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1. Vigtigt

1. Vigtigt
Denne elektroniske brugervejledning er 
beregnet til alle, der bruger Philips-skærmen. 
Tag den tid du behøver for at læse vejledningen, 
inden du bruger skærmen. Den indeholder 
vigtige oplysninger om bemærkninger angående 
brugen af din skærm.

Philips garanti dækker under forudsætning af, 
at produktet behandles korrekt og anvendes til 
det tilsigtede formål i overensstemmelse med 
dens brugervejledning, og ved forevisning af den 
originale faktura eller kvittering med angivelse af 
købsdatoen, forhandlerens navn samt model og 
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og 
vedligeholdelse

� �����
���
Anvendelse af betjeningselementer, justeringer 
eller fremgangsmåder, der ikke er beskrevet i 
denne dokumentation, kan resultere i elektrisk 
stød, elektriske ulykker og/eller mekaniske ulykker.
Læs og følg disse vejledninger, når du tilslutter 
og anvender din computerskærm:

Betjening:
#� Hold skærmen væk fra direkte sollys, 

meget kraftige lyskilder såvel som andre 
varmekilder Længerevarende udsættelse 
for denne slags forhold kan medføre 
misfarvning og beskadigelse af skærmen.

#� Fjern alt, der kan risikere at falde i 
ventilationsåbningerne eller forhindre 
korrekt afkøling af skærmens’ elektronik.

#� Bloker ikke ventilationsåbningerne på kabinettet.
#� Under placering af skærmen skal du sikre 

dig, at det er let at komme til strømstikket 
og stikkontakten.

#� Hvis der slukkes for skærmen ved at fjerne 
strømkablet eller jævnstrømsledningen, 
skal du vente 6 sekunder, før du sætter 
strømkablet eller jævnstrømsledningen til 
igen for at opnå normal betjening.

#� Brug altid et godkendt strømkabel, der 
er leveret af Philips. Hvis du mangler dit 
strømkabel, skal du kontakte dit lokale 
servicecenter. (Se Informationscenter for 
kundepleje)

#� Udsæt ikke skærmen for kraftige vibrationer 
eller stød under anvendelse.

#� Slå ikke på skærmen, og undgå at tabe den 
under brug eller transport.

Vedligeholdelse:
#� Som en beskyttelse af skærmen skal du 

undgå at trykke kraftigt på LCD skærmen. 
Når du flytter din skærm, så tag fat om 
rammen for at løfte den. Løft ikke skærmen 
ved at sætte din hånd eller fingre på LCD 
skærmen.

#� Tag stikket ud fra skærmen, hvis du ikke skal 
bruge den i en længere periode.

#� Tag stikket ud at kontakten til skærmen, hvis 
du skal rengøre den med en let fugtet klud. 
Skærmen kan tørres af med en tør klud, 
når der er slukket for strømmen. Under 
alle omstændigheder, må der ikke bruges 
organiske opløsningsmidler til rengøring af 
din skærm.

#� For at undgå risiko for elektrisk stød eller 
permanent beskadigelse af anlægget, må du 
ikke udsætte skærmen for støv, regn, vand 
eller miljøer med høj fugtighed.

#� Hvis din skæm bliver våd, skal den tørres af 
med en tør klud så hurtigt som muligt.

#� Hvis der kommer fremmed substans eller 
vand ind i skærmen, så sluk straks for 
strømmen og tag stikker ud. Fjern derefter 
den fremmede substans eller vandet, og 
send skærmen til servicecenteret.

#� Skærmen må ikke bruges eller opbevares 
på steder, hvor den udsættes for varme, 
direkte sollys eller ekstrem kulde.

#� For at opretholde den bedste ydelse af 
din skærm og for langvarig brug, bedes du 
bruge skærmen et sted, der er indenfor 
følgende temperatur- og fugtighedsområde.
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#� Temperatur : 0-40 °C 32-95 °F
#� �!��
�$�	%��&*�&�+�8;

Vigtige oplysninger vedrørende 
fastbrændinger/spøgelsesbilleder på skærmen
#� Sørg altid for at aktivere en pauseskærm, 

der bevæger sig, når skærmen efterlades 
uden at blive anvendt. Du skal altid bruge 
en pauseskærm eller et andet program, 
der opdaterer skærmen regelmæssigt, hvis 
skærmen viser statisk materiale i længere 
perioder. Uafbrudt visning af stille eller 
statiske billeder over en længere periode 
kan forårsage, at billedet "brændes fast" på 
skærmen, dvs. de såkaldte "efterbilleder" 
eller "spøgelsesbilleder" på din skærm.

#� "Fastbrænding", "efterbilleder" og 
"spøgelsesbilleder" er velkendte fænomener 
inden for LCD teknologien. I de fleste tilfælde 
vil "brandmærkerne" eller "efterbilledet" eller 
"spøgelsesbilledet" forsvinde gradvist, efter 
skærmen er blevet slukket.

� �����
��
Hvis der ikke bruges en pauseskærm eller et 
program, der opdaterer skærmen periodisk, kan 
der opstå alvorlige tilfælde af "fastbrændinger", 
"efterbilleder" eller "spøgelsesbilleder", som ikke 
forsvinder, og som heller ikke kan repareres.  
Ovennævnte skade er ikke dækket af garantien.

Service
#� Kabinettet må kun åbnes af kvalificeret 

servicepersonale.
#� Hvis der er behov for et dokument til 

reparation eller integration, så kontakt 
dit lokale servicecenter. (Se kapitlet om 
"Kundeinformationscenter")

#� For oplysninger om transport, se "Tekniske 
specifikationer".

#� Efterlad ikke din skærm i en bil/bagagerum 
under direkte sollys.

 Bemærk
Kontakt en servicetekniker, hvis skærmen ikke 
fungerer korrekt, eller hvis du er usikker på, hvad 
du skal gøre, når betjeningsinstruktionerne, der 
er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser
Følgende underafsnit beskriver de 
notationsmæssige konventioner, der benyttes i 
dette dokument.

Bemærkninger, forholdssregler og advarsler
I hele denne vejledning kan tekstafsnit være 
ledsaget af et ikon, og stå med fed eller kursiv 
skrift. Disse afsnit indeholder bemærkninger og 
punkter, hvor der skal udvises forsigtighed, eller 
advarsler. De anvendes som følger :

 Bemærk
Dette ikon angiver vigtige oplysninger og 
tips, hvormed du kan gøre bedre brug af 
computersystemet.

 Forsigtig
Dette ikon angiver oplysninger om, hvordan du 
undgår risiko for skader på hardwaren eller tab 
af data.

� �����
��
Dette ikon angiver risiko for personskader, og 
hvordan dette undgås.
Visse advarsler kan optræde i andre formater, og 
er eventuelt ikke ledsaget af et ikon. I sådanne 
tilfælde er den givne udformning af advarslen 
lovmæssigt obligatorisk.
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1.3 Bortskaffelse af produkt og 
emballage

Elskrot WEEE (Waste Electrical and Electronic 
Equipment)

This marking on the product or on its 
packaging illustrates that, under European 
Directive 2002/96/EC governing used electrical 
and electronic appliances, this product may 
not be disposed of with normal household 
waste. You are responsible for disposal of 
this equipment through a designated waste 
electrical and electronic equipment collection. 
To determine the locations for dropping off 
such waste electrical and electronic, contact 
=�!����>�����?�����������>�@��$��G�����	
�J�����
organization that serves your household or the 
store at which you purchased the product.

Your new monitor contains materials that can 
be recycled and reused. Specialized companies 
can recycle your product to increase the 
amount of reusable materials and to minimize 
the amount to be disposed of. 

All redundant packing material has been 
omitted. We have done our utmost to make the 
packaging easily separable into mono materials.

���������	��!���M�!���$����>������!���
�������
how to dispose of your old monitor and packing 
from your sales representative. 

Taking back/Recycling Information for 
Customers
Philips establishes technically and economically 
viable objectives to optimize the environmental 
performance of the organization's product, 
service and activities.

From the planning, design and production 
stages, Philips emphasizes the important of 
making products that can easily be recycled.  At 
Philips, end-of-life management primarily entails 
participation in national take-back initiatives 
and recycling programs whenever possible, 
preferably in cooperation with competitors, 
which recycle all materials (products and related 
packaging material) in accordance with all 
Environmental Laws and taking back program 
with the contractor company.

Your display is manufactured with high quality 
materials and components which can be 
recycled and reused.

To learn more about our recycling program 
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page
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2. Opsætning af skærm

2.1 Installation

 Emballagens indhold

 

 

17S4

  保留备用

使用 前请阅读使用说明

17S4C

Strøm �����������	� Lyd (valgfri)

 Fjernelse af foden
17S4

1. Q�����������JR����M�X	��?����	�@���	�
forsiden nedad. Undgå, at ridse eller 
beskadige skærmen.

2. Hold foden med begge hænder.
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2. Opsætning af skærm

17S4C

1. Q�����������JR����M�X	��?����	�@���	�
forsiden nedad. Undgå, at ridse eller 
beskadige skærmen.

2. Tryk foden fast på VESA-
monteringsområdet.

3. Hold foden med begge hænder.
(1) Sæt forsigtig foden på støtten således, 

at de tre stifter ligger i positionshullerne.

(2) Z�!��	
����������
����������J��	��
skruen under foden, og sørg for at 
foden er ordentlig fastspændt på søjlen.

2

1
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2. Opsætning af skærm

 Tilslutning til PC

17S4

1 2 3
4

4

5

1

2
3

6

17S4C

1  AC-strømindgang
2  DVI-indgang (på udvalgte modeller)
3 � ["
*
�	����
4  Kensington anti-tyverisikring
5  Lydindgang (17S4A)
6  Hovedtelefonstik (17S4A)

Tilslutning til pc

1. Tilslut ledningen ordentligt pa bagsiden af 
skærmen.

2. Sluk for computeren og tag netledningen ud 
af stikket.

3. Slut skærmens signalkabel til videostikket bag 
på computeren.

4. Sæt computerens og skærmens netledninger 
til et stik i nærheden.

5. Tænd for computeren og skærmen. Hvis 
skærmen viser et billede, er installationen 
gennemført.

2.2 Brug af skærm

 Beskrivelse af betjeningsknapperne

17S4C/17S4

7 6 25 4

3

1

!"#��

7 6 25 4

3

1

Tænder og slukker for skærmen.
Sådan får du adgang til OSD-menuen.
Bekræft justering i skærmmenuen.
Til justering i skærmmenuen.

Vælg kontrolniveauet SmartPower

Indstilling af lysstyrken på skærmen.

Indstilling af lydstyrke på skærmen.

"R��
�M�����
��	�������
���\�]*�
?��!�
SmartImage genvejstast. Der kan 
?�������������^��!���
����%�\��>��
(Kontor), Photo (Foto), Movie 
`�
��{@�"����`�J
�{@�|>����=�
(Økonomi) og Off (Fra).

1 2 3

4

1

2

3

5
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2. Opsætning af skærm

 Beskrivelse af OSD-skærm

Hvad er OSD (On-Screen Display)?
Visning på skærmen On-Screen Display (OSD) er en 
funktion på alle Philips LCD skærme. Den sætter en 
slutbruger i stand til at justere skærmindstillingerne, 
eller vælge skærmens funktioner direkte via et 
instruktionsvindue på skærmen. Et brugervenligt 
skærmvisningsinterface vises som nedenfor:

�����

���	�
�

��
�


��������

����	
���

���

��
�


���	�
�

���

���

���
����	

��������

������		����

��������

��
�


���	�
�

������		����

��	��

�
���	������������������

���	
��	�

���
	���	
��	 ���

����� � �

!""

#"

Grundlæggende og enkle anvisninger til 
kontrolknapperne
I skærmmenuen ovenfor, kan du bruge  

����JJ�����������JR����������
������=����
markøren med, og tryk på OK knappen, til at 
bekræfte dit valg eller ændring.

OSD-menuen
Nedenstående er en generel oversigt over 
strukturen i OSD-displayet. Du kan anvende 
den som opslag, når du senere skal orientere dig 
i de forskellige justeringer.
Main menu Sub menu

Picture

OSD Settings

Setup

Language

Color

Input

Audio 

Brightness

Contrast

Horizontal

Vertical

Transparency

OSD Time Out

Auto

V.Position

Phase

Clock

Resolution Notification

Reset

Information

English, Deutsch, Español, Ελληνική, Français, Italiano,
Maryar, Nederlands, Português, Português do Brazil,
Polski, Русский, Svenska, Suomi, Türkçe, Čeština,
Українська, 體 語, 한국어

Color Temperature

sRGB

User Define

VGA

DVI

Volume

Mute

SmartContrast

Gamma

H.Position

0~100

0~100

0~100

0~100

Off, 1, 2, 3, 4

5, 10, 20, 30, 60

On, Off

Yes, No

0~100

0~100

0~100

5000K, 6500K, 7500K,
8200K, 9300K, 11500K

Red: 0~100

Green: 0~100

Blue: 0~100

On, Off

0~100

On, Off

1.8, 2.0, 2.2, 2.4, 2.6 

0~100

VGA

100

50

Off

2.2

80

Off

6500

100

100

100

English

50

50

Off

20

ON

No

K
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 Meddelelse om opløsning
Denne skærm er fremstillet til optimal ydelse på 
	�������
?���J�X��
��@�����������&�}��&�~�?�	�
60 Hz. Når skærmen bruger en anden opløsning, 
�����X����	���	?������JR��������%��������&�
���&�~���^&�;������M�������!����`Z�!�����&�}�
1024 ved 60 Hz for at opnå det bedste resultat).

Advarslen vedrørende den naturlige opløsning 
kan deaktiveres under Installation i OSD 
(skærmmenuen).

 Fysisk funktion

Vip

20

-5

�!"#�$!"#��$!"#�%�

Drej

-65
65

(17S4C)

Højdejustering

110mm

(17S4C)
Drejetap

0°

90°

(17S4C)
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2.3 �������������������&��������'#�*
kortet

Inden du begynder at adskille skærmens fod, skal 
du følge vejledningerne nedenfor for at undgå 
mulig beskadigelse eller personskade.

!"#�$!"#��

1. Q�����������JR����M�X	��?����	�@���	�
forsiden nedad. Undgå, at ridse eller 
beskadige skærmen.

2. Z�!�������	$�?�	������!����������
�����
�������	���������!���J���������M���
	������
skærmen.

3. Fjern skruerne fra bagsiden af skærmen.

4. Fjern foden.

17S4C

1. Q�����������JR����M�X	��?����	�@���	�
forsiden nedad. Undgå, at ridse eller 
beskadige skærmen.
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2. Fjern skruerne fra bagsiden af skærmen. 

1

2

3. Hold udløserknappen inde, vip foden og 
træk den ud.

1

2

 Bemærk
Denne skærm accepterer et 100mm x 100 mm 
monteringsinterface.

100mm

100mm
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3. Billedoptimering

3.1 SmartContrast

 Hvad er dette?
Unik teknologi, der dynamisk analyserer det viste 
indhold, og automatisk optimerer skærmens 
kontrastforhold til maksimal visuel klarhed. 
Den øger baggrundsbelysningen og giver et 
klarere, friskere og lysere billede eller dæmper 
baggrundsbelysningen med henblik på en tydelig 
visning af billeder på en mørk baggrund.

 Hvorfor behøver jeg det?
Du ønsker den allerbedste visuelle klarhed 
og visning på enhvert indhold. Smart-kontrast 
styrer den dynamiske kontrast og indstiller 
baggrundslyset, så det giver klare, friske og 
lyse spil- og videobilleder, samt viser en 
tydelig, læsbar tekst ved kontorarbejde. Ved at 
nedsætte skærmens strømforbrug, sparer du 
energiomkostninger og forlænger skærmens 
levetid.

 Hvordan virker det?
Når du aktiverer SmartContrast, analyseres 
det viste indhold i realtid, og farver og 
baggrundslysets intensitet indstilles. Denne 
funktion forbedrer den dynamiske kontrast og 
giver således en bedre underholdningsoplevelse, 
når du ser videoer eller spiller spil.

3.2 Philips SmartControl Premium
Det nye SmartControl Premium-software fra 
Phillips giver dig mulighed for at kontrollere 
��������?
���������@��������
������>���
Komplicerede justeringer hører fortiden til. 
Dette brugervenlige software guider dig 
���������
�	��
��
�������J�X��
��@����
M���
������
���?�@��!����
������>��>��
�������@�8"Z*$?
	J!����
osv.

Dette iøjefaldende, ikon-baseret software er 
udstyret med den seneste teknologi i algoritmer 
for hurtig behandling og reaktion, og er tilmed 

Windows 7 kompatibel, og klar til at forbedre 
din oplevelse med Philips-skærme!

 Installation
#� Følg instruktionen og fuldfør installationen.
#� Du kan starte, når installationen er fuldført.
#� Hvis du vil begynde senere, kan du klikke 

på genvejen på skrivebordet eller på 
værktøjslinjen.

Opstartsguide
#� Efter installation af SmartControl Premium 

starter guiden automatisk, når du åbner 
programmet første gang.

#� "!
	�����	���	
����
��������
���������
indstillingen af skærmen.

#� Du kan også gå til Plug-in menuen, for at 
starte guiden på et senere tidspunkt.

#� I Standard-vinduet kan du indstille flere 
funktioner uden brug af guiden.
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 Start med Standard-vinduet

���+
��&��+��0��
�	��	��
�
#� Med Adjust (Indstillings) menuen kan du 

indstille Brightness (Lysstyrken), Contrast 
`��������{@����8����!�
���`\J�X��
��{�

#� Udfør indstillingen ved at følge 
instruktionerne.

#� Installationen kan annulleres med Annuller.

Color (Farve) menuen
#� Med Color (Farve) menuen kan du 


�	��
����8"Z@�Z��>��Q�?���`�����
?��!{@�
�$
�����
���`;?
	J!���{@�]
�J��=�"�����
(Skærmgamma), Calibration (Kalibrering), 
SmartImage og SmartKolor.

#� Udfør indstillingen ved at følge 
instruktionerne.

#� Se nedenstående oversigt med 
undermenupunkter baseret på din 
indtastning.

#� Eksempel på Color Calibration 
(Farvekalibrering).
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1. "Show Me" (Vis Mig) starter vejledningen til 
farvekalibrering.

2. Start – starter en 6-trins 
farvekalibreringssekvens.

3. �!
>��[
�G�`;!��
�?
��
��{�
�	�������X��
efter-billederne.

4. For at vende tilbage til Color (Farve) 
vinduet, skal du klikke på %����������+�����.

5. Enable color calibration (Aktiver 
farvekalibrering) - der som standard er 
aktiveret. Hvis markeringen er fjernet, kan 
du ikke udføre en farvekalibrering, ligesom 
�����*�����!
>��[
�G�`;!��
�?
��
��{�
knapperne er gråtonede.

6. Der skal være patentoplysninger på 
kalibreringsskærmen.
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Første Farvekalibrering-skærm

#� Previous (Foregående) knappen er 
deaktiveret, indtil du går videre til den 
anden farveskærm.

#� Next (Næste) går til efterfølgende mål 
(seks mål).

#� Til sidst gå til File > Presets (Fil > Forvalg) 
vinduet.

#� Cancel (Annuller) lukker UI og vender 
tilbage til Plug-in siden.

SmartImage
"
?���M�!�������!�
�$�	����������	���
indstillingerne, så der opnås en bedre 
skærmindstilling baseret på indholdet.

Når der indstilles på Underholdning, aktiveres 
Smart-Kontrast og Smart-Svar.

Eco Power (Strømbesparings) menuen

Options (Funktioner) menuen
Options > Preferences (Funktioner > Indstillinger) 
- er kun aktiv, når Preferences (Indstillinger) er valgt 
i Options (Funktioner)-rullemenuen. På en ikke-
understøttet skærm med DDC/Ci er kun Help 
(Hjælp) og Options (Funktioner) til rådighed.

#� Viser nuværende, foretrukne indstillinger.
#� Funktionen aktiveres ved at afmærke feltet. 

Afmærkningsfeltet er en flip-flop.
#� Enable Context Menu (Aktiver Indhold 

menuen) er som standard afmærket (Til) på 
skrivebordet. Enable Context Menu (Aktiver 
Indhold menuen) viser valgmulighederne i 
SmartControl Premium på Select Preset 
(Vælg Forvalg) og Tune Display (Indstil 
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Display) i genvejmenuen ved at højreklikke 
på skrivebordet. Deaktiveret fjerner 
SmartControl Premium fra genvejsmenuen.

#� Enable Task Tray (Aktiver Jobbakke) menuen er 
som standard afmærket (Til) på skrivebordet. 
Enable Context Menu (Aktiver Indhold menuen) 
gør, at systembakkens ikon til SmartControl 
Premium vises. Et højreklik på jobbakke-ikonen 
viser menufunktionerne for Help (Hjælp) og 
Technical Support (Teknisk Support). Check for 
Update (Tjek for opdateringer), About (Om) 
og Exit (Afslut). Når Enable Task Tray (Aktiver 
Jobbakke) menuen er deaktiveret, viser jobbakke-
ikonen kun Exit (Afslut).

#� 8!����������!J�`�X��?�	��J�����{����
som standard afmærket (Til). Når den er 
deaktiveret, starter SmartControl Premium 
ikke ved opstart og ikonet vises ikke i 
systembakken. SmartControl Premium kan 
kun startes fra genvejen på skrivebordet eller 
fra programfilen. Intet forvalg, som er indstillet 
til at køre ved opstart, indlæses når denne 
boks ikke er afmærket (er deaktiveret).

#� Aktivér gennemsigtighedstilstand (Windows 7, 
[
���@���{������	��	����&+�!
�������
��
�$�	�

9��	��
�;��+�	����+���	�����;�<=�� - er 
kun aktiv, når Audio (Lyd) er valgt i Options 
(Funktioner) rullemenuen.

På en ikke-understøttet skærm med DDC/Ci 
er kun Help (Hjælp) og Options (Funktioner) til 
rådighed.

9��	��;�+���@	������0��
�	��	����;A�����+��&��

Options > Input (Funktioner > Indgang) 
- er kun aktiv, når Input (Indgang) er valgt i 
Options (Funktioner) rullemenuen. På en ikke-
understøttet skærm med DDC/Ci er kun Help 
(Hjælp) og Options (Funktioner) til rådighed. 
Alle andre faneblade i SmartControl Premium 
er ikke til rådighed.

#� Vis Source (Kilde) instruktionsvinduet og 
nuværende indgangskildeindstillinger.

#� På enkeltindgangsskærme ses dette vindue 
ikke.
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Options > Theft Deterrence (Funktioner > 
���	*�=���	� - Theft Deterrence (Anti-tyveri)-
vinduet er kun aktiv, når Theft Deterence Mode 
(Anti-tyveri funktionen) er valgt i Plug-in-
rullemenuen.

For at aktivere Theft Deterence (Anti-tyveri), 
skal du klikke på On (Til)-knappen, hvorefter 
følgende skærm vises:

#� Der kan kun indtastes en PIN-kode på fire 
til ni cifre.

#� Når PIN-koden er indtastet, leder Accept 
knappen brugeren til pop-op dialogboksen 
på følgende side.

#� Minimum antal minutter er fem. Pilen står 
som standard på 5.

#� Kræver ikke, at skærmen forbindes til en 
anden vært for at gå i Theft Deterrence 
(Anti-tyveri) funktionen.

Når der er oprettet en PIN-kode, indikerer 
Theft Deterence (Anti-tyveri) vinduet, at Theft 
Deterence (Anti-tyveri) er aktiveret, hvorefter 
en PIN-kode funktionsknap kan ses:

#� Theft Deterence (Anti-tyveri) Aktiveret 
kan ses.

#� Deaktiver Theft Deterrence (Anti-tyveri) 
funktionen åbner i et vindue på næste side.

#� PIN-kode funktionsknappen virker kun, 
når brugeren har oprettet en PIN-kode. 
Knappen åbnes i et sikkert PIN-kode 
websted.

Help (Hjælp) menu
Help > User Manual (Hjælp > Brugervejledning) 
- er kun aktiv, når User Manual (Brugervejledning) 
er valgt i Help (Hjælp) rullemenuen. På en ikke-
understøttet skærm med DDC/Ci er kun Help 
(Hjælp) og Options (Funktioner) til rådighed.

Help > Version (Hjælp > Version) - er kun aktiv, 
når Version er valgt i Help (Hjælp) rullemenuen. 
På en ikke-understøttet skærm med DDC/Ci 
er kun Help (Hjælp) og Options (Funktioner) til 
rådighed.
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Context Sensitive Menu (Indholdssensitiv menuen)
Context Sensitive Menu (Indholdssensitiv 
menuen) er som standard aktiveret. Hvis 
Enable Context Menu (Aktiver Indholdssensitiv 
menuen) er afmærket i Options > Preferences 
(Funktioner > Indstillinger) vinduet, ses menuen.

�����}�����!�`��	$��	���!��{�$�������J!�����

J� SmartControl Premium - når valgt, ses 
About (Om) skærmen.

J� Select Preset (Vælg Forvalgt) – herefter vises 
en hierakisk menu med gemte forvalg, der straks 
kan bruges. En afkrydsning viser det nuværende 
valgte forvalg. Factory Preset (Fabriksindstillinger) 
kan også hentes i rullemenuen.

J� Tune Display (Indstil Skærm) - åbner 
kontrolpanelet til SmartControl Premium.

J� SmartImage - kontroller de aktuelle 
indstillinger : Off (Fra), Office (Kontor), 
Photo (Foto), Movie (Film), Text (Tekst), 
"����`�J
�{@�|>����=�`������
{�

Jobbakke menu aktiveret
Menuen i systembakken kan ses ved at 
højreklikke på SmartControl Premium-ikonet i 
systembakken. Et venstreklik starter programmet.

Jobbakken har fem punkter :

J� Help (Hjælp) - adgang til brugervejledningsfilen: 
Åbner Brugervejledningen med standard 
browservinduet.

J� Technical Support (Teknisk Support) - 
Viser siden med teknisk support.

J� Check for Update (Tjek for opdateringer) 
- Leder brugeren til PDI Landing og tjekker 
brugerens version i forhold til den nyeste version.

J� �X�+���9&� - Viser detaljerede 
referenceoplysninger : Produktversion, 
udgivelsesinformation og produktnavn.

J� 'Y	�����
�+�� - Luk SmartControl Premium.
Hvis du vil køre SmartControl Premium igen, 
skal du enten vælge SmartControl Premium i 
Program menuen, dobbeltklikke på skrivebordet 
eller genstarte systemet.

Jobbakke menu deaktiveret
Når Jobbakke er deaktiveret i indstillinger-
mappen, er kun Exit (Afslut) valgmuligheden til 
rådighed. Hvis du helt vil fjerne SmartControl 
Premium fra systembakken, skal du deaktivere 
8!����������!J�`�X��?�	��J�����{�
�\J�
������
Preferences (Funktioner > Indstillinger).

 Bemærk
Alle billederne i dette afsnit er kun til 
referenece. SmartControl-softwareversionen 
kan ændres uden varsel. Kontroller venligst den 
���>
�����J������*$������
	���www.portrait.
com/dtune/phl/enu/index, for at downloade den 
seneste version af SmartControl softwaret.
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3.3 SmartDesktop vejledning

 SmartDesktop
SmartDesktop er en del af SmartControl 
Premium. Installér SmartControl Premium og 
vælg SmartDesktop under Options (Funktioner).

#� Afkrydsning af Align to partition (Tilpas til 
afsnit) vil aktivere automatisk tilpasning af 
?
�	!����R��	������������
��	���	������	������
��

#� Vælg det ønskede afsnit ved at klikke på 
ikonet. Afsnittet anvendes på skrivebordet 
og ikonet fremhæves.

#� Identify (Identificer) giver mulighed for 
hurtigt at vises gitret.

 Træk og slip vinduer
�R������
��������������!����	�����	!�$���?�����
Tilpas til afsnit, kan du trække et vindue ind i 
området, hvorefter det tilpasses automatisk. Når 
vinduet og musemarkøren er inden i området, 
fremhæves dette område.

 Bemærk
Hvis områdets yderkant ikke er synlig når du trækker 
vinduet, er indstillingen "Show windows contents 
while dragging (Vis indhold i vindue, mens der 
trækkes)" deaktiveret. Sådan aktiveres indstillingen:

1. Klik på System i Control Panel 
(Kontrolpanelet).

2. Klik på Advanced system settings (Avancerede 
�=����
�	��
��
����{�`
�[
��������
�����	���
denne indstilling i venstre sidelinje).

3. I afsnittet Performance (Ydelse), klik på 
Settings (Indstillinger).

4. Afkryds "Show windows contents while 
dragging (Vis indhold i vindue, mens der 
trækkes)", og klik på OK.

��������������	��
�	Z

Vista:
Control Panel (Kontrolpanel) > Personalization 
(Personlige indstillinger) > Window Color and 
Appearance (Vinduesfarve og -udseende) > 
klik på "Open Classic appearance properties for 
more color options (Åbn klassisk visning for at få 
��������?�
�	��
��
����{������
��JR����JJ����|���>���
(Effekter)" > afkryds Show windows contents while 
dragging (Vis indhold i vindue, mens der trækkes).

XP:
Display Properties (Egenskaber for skærm) > 
Appearance (Udseende) > Effects... (Effekter...) > 
Afkryds Show window contents while dragging (Vis 
indhold i vindue, mens der trækkes).

Win 7:
Ingen anden alternativ sti er tilgængelig.
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 Valgmuligheder i titellinjen
Desktop Partition (Deling af skrivebordet) kan 
åbnes fra titellinjen i et aktivt vindue. Det giver 
en hurtig og nem måde at styre skrivebordet 
på, såvel som en metode til at sende et vindue 
til et afsnit på, uden brug af træk og slip. Flyt 
markøren over på det aktive vindues titellinje, 
for at få adgang til rullemenuen.

 Højreklik-menuen
Højreklik på ikonet til Desktop Partition (Deling 
af skrivebordet) for at vise rullemenuen.

#� Find Windows (Find vinduer) – I visse 
�
����	��$���	!��!�
�?
������������?
�	!���
til det samme afsnit. Find Windows (Find 
vinduer) viser alle åbne vinduer, og ligger 
det valgte vindue øverst.

#� Desktop Partition (Deling af skrivebordet) 
– Desktop Partition (Deling af skrivebordet) 
viser den aktuelle valgte deling, og giver 
brugeren mulighed for hurtigt at skifte til en 
af delingerne, som er vist i rullemenuen.

 Bemærk
Hvis der er tilsluttet mere end én skærm, kan 
du vælge målskærmen for at skifte afsnittet. Det 
fremhævede ikon repræsenterer det aktive afsnit.

#� 0����	�=�@���	�	����0����	
������
�	�� – 
Viser gitret til det aktuelle afsnit.

#� ��	���9�$��	���9�����	���
��	�$���� – 
Aktiverer/deaktiverer den automatiske 
tilpasningsfunktion ved brug af træk og slip.

#� 'Y	�����
�+�� – Lukker Desktop Partition 
(Deling af skrivebordet) og Display Tune 
(skærmindstillingen). Du kan genstarte 
Display Tune (skærmindstillingen) fra Start 
menuen eller via genvejen på skrivebordet.

 Venstreklik-menuen
Venstreklik på ikonet til Desktop Partition 
(Deling af skrivebordet) for hurtigt at sende det 
aktive vindue til et afsnit uden brug af træk og 
slip. Når du slipper med musen, sendes vinduet 
til det fremhævede afsnit.

 Højreklik i systembakken
�=����M�������
����
�	�$��	������R�	��������
funktioner, som er understøttet af titellinjen 
(med undtagelse af at sende et vindue til et 
afsnit).



20

3. Billedoptimering

#� Find Windows (Find vinduer) – I visse 
�
����	��$���	!��!�
�?
������������?
�	!���
til det samme afsnit. Find Windows (Find 
vinduer) viser alle åbne vinduer, og ligger 
det valgte vindue øverst.

#� Desktop Partition (Deling af 
skrivebordet) – Deling af skrivebordet 
viser den aktuelle valgte deling, og 
giver brugeren mulighed for hurtigt at 
skifte til en af delingerne, som er vist i 
rullemenuen.

#� 0����	�=�@���	�	����0����	
������
�	�� – 
Viser gitret for det aktuelle afsnit.

#� ��	���9�$��	���9�����	���
��	�$���� – 
Aktiverer/deaktiverer den automatiske 
tilpasningsfunktion ved brug af træk og slip.



21

3. Billedoptimering

� A�
�	�	���������#&���A�
�������
�	�

Navn Beskrivelse Billede
Full Desktop  
(Hele skrivebordet)

Anvender alle indstillinger på hele skrivebordet.

Vertical (Lodret) Vurderer skærmopløsningen og opdeler skærmen i to 
lige store, lodrette områder.

�����&���&�M�?�������	���������!���
���

Horizontal 
(Horisontal)

Vurderer skærmopløsningen og opdeler skærmen i to 
lige store, vandrette områder.

�����&���&�M�?�����?��	���������!���
���

Vertical Triple  
(Lodret tredobbelt)

Vurderer skærmopløsningen og opdeler skærmen i tre 
lige store, lodrette områder.

På 90 afsnit, 1 vandret topafsnit, 2 vandrette midterafsnit, 
3 vandrette bundafsnit.
På 270 afsnit, 3 vandret topafsnit, 2 vandrette 
midterafsnit, 1 vandrette bundafsnit.

Vertical Split Left 
(Lodret opdeling, 
venstre)

Vurderer skærmopløsningen og opdeler skærmen i to 
lodrette områder, venstre side er et enkelt område, 
højre side er opdelt i to lige store områder.
På 90, partition 1 foroven, partition 2 og 3 forneden. 
På 270, partition 1 forneden, partition 2 og 3 foroven.

[���
>����J�
��8
�$��
(Lodret opdeling, 
højre)

Vurderer skærmopløsningen og opdeler skærmen i 
to lodrette områder, højre side er et enkelt område, 
venstre side er opdelt i to lige store områder.
På 90, partition 1 og 2 foroven, partition 3 forneden. 
På 270, partition 3 foroven, partition 1 og 2 forneden.
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Navn Beskrivelse Billede
Horizontal Split Top 
(Vandret opdeling, 
top)

Vurderer skærmopløsningen og opdeler skærmen 
vandret i to lige store områder. Topregionen er enkelt, 
og bundregionen er opdelt i to lige store områder
På 90 partition 1 i højre side, lodret partition 2 og 3 i 
venstre side, lodret.
På 270 partition 1 i venstre side, lodret partition 2 og 3 
i højre side, lodret.

Horizontal Split 
Bottom (Vandret 
opdeling, bund)

Analyserer skærmopløsningen, og opdeler skærmen 
vandret i to lige store områder, hvoraf den nederste del 
ikke er delt op, og den øverste del er delt op i to lige 
store områder. 
På 90, partition 1 og 2 til højre, og partition 3 til venstre. 
På 270, partition 1 og 2 til venstre, og partition 3 til 
højre.

Even Split  
(Lige opdeling)

[!�	�����������J�X��
���������J	�������������
�����
lige store områder.
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4. Tekniske specifikationer
Billede/Skærm
Skærmpaneltype TFT-LCD
Baggrundslys CCFL
Panelstørrelse 43.2cm (17")
Billedforhold 5:4
Pixel pitch 0,264 x 0,264 mm
Lysstyrke 250 cd/m²
SmartContrast 100.000.000:1 
Kontrastforhold (typ.) 1000:1
Svartid 5 ms
Optimal opløsning ���&�}��&�~�?�	�^&�;�
Synsvinkel ��&��`;{����^&��`[{�?�	���8����&
Skærmfarver 16,7 M
Vertikal opdateringshastighed 56 Hz - 76 Hz
Horisontal frekvens �&��;��*�����;�
�8"Z JA
Tilslutningsmuligheder
Inputsignal ][��`	
�
���{@�["
�`������{
Indgangssignal (17S4/17S4C) Separat synk., synk. på grøn
Lydind- og udgang (17S4A) Pc-lydindgang, hovedtelefonstik
Behagelighed
Indbyggede højttalere (17S4A) 1,5W x 2

Brugerfunktioner
 (17S4C/17S4)
 (17S4A)

OSD sprog

|���
�$@�]�!��>$@�|�J����@���������@�������
�@�����
���@����=��@�
��	�����	�@�����!�!��@�����!�!���	��Z���
�@������
@�� ¡¡¢£¤@�
�?�����@��!��
@�¥¦����@�§�¨�
��@�©¢ª«¬­¡®¢«@�

Andre funktioner Kensington-lås
"Plug and Play" kompatibilitet ]]����@��8"Z@��
�	�G������[
������@���>�\��@�Q
�!}
Fod
Vip -5 / +20
Drejeområde (17S4C) -65/+65
Højdejustering (17S4C) 110mm

Strøm

Tændt-tilstand 17,1W (typ.) 25,0W (maks.) (17S4A)
17,1W (typ.) (17S4/17S4C)

Energiforbrug
(energistjerne testmetode)

AC 
tilslutningsspænding 
på 100 VAC, 50 Hz

AC 
tilslutningsspænding 
på 115 VAC, 60 Hz

AC 
tilslutningsspænding 
på 230 VAC, 50 Hz

Normal funktion (typ.) 
(17S4A) 9,46W 9,77W 9,90W
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Normal funktion (typ.) 
(17S4/17S4C) 9,44W 9,76W �@���

I dvale (Standby) 0,2W (typ.) 0,2W (typ.) 0,2W (typ.)
Fra 0,2W (typ.) 0,2W (typ.) 0,2W (typ.)

Varmetab*
AC 
tilslutningsspænding 
på 100 VAC, 50 Hz

AC 
tilslutningsspænding 
på 115 VAC, 60 Hz 

AC 
tilslutningsspænding 
på 230 VAC, 50 Hz

Normal drift (17S4A) 32,29 BTU/t 33,34 BTU/t 33,79 BTU/t
Normal drift (17S4/17S4C) 32,22 BTU/t 33,31 BTU/t 33,72 BTU/t
I dvale (Standby) &@^��Z¥��� &@^��Z¥��� &@^��Z¥���
Fra &@^��Z¥��� &@^��Z¥��� &@^��Z¥���
Strømdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)
Strømforsyning Indbygget, 100-240 VAC, 50/60 Hz
Mål

Produkt uden fod (B x H x D) 446,0 X 450,0 X 160,0 mm (17S4A/17S4)
���@&���~�^@&�����^@&����`���~�{

Produkt uden fod (B x H x D) ´´´@&������@&���^´@&���
Vægt

Produkt med fod 3,535 Kg (17S4A/17S4)
5,02 Kg (17S4C)

Produkt uden fod 3,14 Kg

Produkt med emballage 4,935 Kg (17S4A/17S4)
6,166 Kg (17S4C)

Driftsforhold
Temperaturområde (drift) 0°C til 40°C
Temperaturområde
(Ikke drift) -20°C til 60°C

8����
?��!��
�$�	 �&+��
���&+
MTBF 30.000 timer
Miljømæssige forhold
8\;� JA
Emballage �&&+����M�!���
�
�J�>
����$�?�	
�	$��	 �&&+��[��Z�8*��
���M
���
Overholdelse og standarder

Myndighedernes godkendelser CE-mærket, FCC klasse B, SEMKO, ETL, BSMI, CU, VCCI, TUV-
"�@�¥�[*|8"\@���Z@��*¥���@���8
����

Kabinet
Farve Sort/Sølv
Finish Struktur

 Bemærk
1. ]
����	����������	����!	���?�������"R��
��www.philips.com/support for at hente den seneste 

version af brochuren.
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4.1 Opløsning og forudindstillede 
funktioner

 Maksimal opløsning
���&�}��&�~�?�	�^&�;��`�������
�	����{
���&�}��&�~�?�	�^&�;��`	
�
����
�	����{

� ��X����������\
�	��
���&�}��&�~�?�	�^&�;��`	
�
����
�	����{

V frekv. 
(kHzx)

Opløsning L frekv. (Hz)

31,47 720x400 70,09
31,47 ^~&}~�& 59,94
35,00 ^~&}~�& 66,67
��@�^ ^~&}~�& ��@��
37,50 ^~&}~�& 75,00
��@�� �&&}^&& 60,32
~^@�� �&&}^&& 75,00
~�@�^ �&�~}�^� 60,00
60,02 �&�~}�^� 75,03
��@�� ���&}�&�~ 75,03
^�@�� ���&}�&�~ 60,02
44,77 ���&}��& ´�@�^

 Bemærk
Bemærk venligst, at din skærm virker bedst med 
���
?���J�X��
���JR����&����&�~�?�	�^&;�������
at opnå den bedste skærmkvalitet, bedes du 
venligst bruge denne opløsning.
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5. Strømstyring
Hvis der er installeret et skærmkort eller 
software på pc’en, der er i overensstemmelse 
med VESA DPM, kan skærmen automatisk 
nedsætte strømforbruget, når den ikke bruges. 
Hvis en tilslutning fra et tastatur, mus eller anden 
��$�	���	��@��?R���������������!�����
���
�����
Nedenstående tabel viser denne automatiske 
energisparefunktions strømforbrug og 
signalering:

|����
�J���*	���
�
��
VESA 
tilstand Video V synk L synk Opbrugt strøm LED Farve

Aktiv TIL Ja Ja 17,1W (typ.) Hvid

I dvale 
(Standby) �8
 Nej Nej 0,2W (typ.) Hvid 

(blinker)

Kontakt Fra �8
 - - 0,2 W (typ.) �8


Følgende opsætning bruges til at måle 
skærmens strømforbrug.

#� ��	M=������J�X��
��%����&�}��&�~
#� ��������%�´&+
#� Lysstyrke: 250 nits
#� Farvetemperatur : 6500k med fuldt, hvidt 

mønster

 Bemærk
Disse data kan ændres uden varsel.
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6. Lovmæssige oplysninger
Lead-free Product

Lead free display promotes 
environmentally sound recovery 
and disposal of waste from electrical 
and electronic equipment. Toxic 

substances like Lead has been eliminated 
and compliance with European community’s 
���
������8�;��	
��>�
?�����	��
��������
>�
����
on hazardous substances in electrical and 
electronic equipment have been adhered to 
in order to make Philips monitors safe to use 
throughout its life cycle.

CE Declaration of Conformity
This product is in conformity with the following 
standards 

#� EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of 
Information Technology Equipment).

#� |�´´&��%�&�&�`8�	
��]
��!�M��>��
requirement of Information Technology 
Equipment).

#� EN55024:2010 (Immunity requirement of 
Information Technology Equipment).

#� EN61000-3-2:2006 +A1:2009+A2:2009 
(Limits for Harmonic Current Emission).

#� |�^�&&&*�*�%�&&��`Q
�
���
������[�������
Fluctuation and Flicker) following provisions 
of directives applicable.

#� 2006/95/EC (Low Voltage Directive).
#� �&&~��&��|��`|���]
��>�
?�{�
#� 2009/125/EC (ErP Directive, EC No. 

���´��&&����J������
���]
��>�
?��
for Standby and Off mode power 
consumption) and is produced by a 
manufacturing organization on ISO9000 
level.

The product also comply with the following 
standards 

#� ��\��~�*�&�%�&&��`|������
>�
requirement, Analysis and compliance test 
methods for electronic visual displays).

#� EK1-2000:2013�`"���������µ!
������{�
#� J�|�´&���%�����`Q�G����µ!��>=�|��>��
>�

and Magnetic fields for Visual Display).
#� ��8*���`��8%���&%�����&%�&�Q�G�

Frequency Electric and Magnetic fields).
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Federal Communications Commission (FCC) 
Notice (U.S. Only)

 This equipment has been tested and found 
to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC 
8!�����¥$�����
�
�������	��
���	����J��?
	��
reasonable protection against harmful 
interference in a residential installation. 
This equipment generates, uses and can 
radiate radio frequency energy and, if not 
installed and used in accordance with the 
instructions, may cause harmful interference 
to radio communications.  
 
However, there is no guarantee that 
interference will not occur in a particular 
installation. If this equipment does cause 
harmful interference to radio or television 
reception, which can be determined by 
turning the equipment off and on, the 
user is encouraged to try to correct 
the interference by one or more of the 
following measures: 

#� 8���
�����������>�����$����>�
?
�����������
#� Increase the separation between the 

equipment and receiver.
#� Connect the equipment into an outlet on 

a circuit different from that to which the 
receiver is connected.

#� Consult the dealer or an experienced 
radio/TV technician for help.

� �$�����������	
�>��
���������}J�����=�
approved by the party responsible for 
compliance could void the user's authority 
to operate the equipment.

�������=�8���$
��	�	�>�M����$���G����!JJ�
�	�
with the monitor when connecting this monitor 
to a computer device. 

¥��J��?����	������G$
>$���=����!���
���������
shock hazard, do not expose this appliance to 
rain or excessive moisture. 

¥;����Q
���Z�]�"�¥
Q�
��
8
¥����||¥��

QQ�8|���8|�|�¥��\��¥;|��
�
]�
��
��¥|8�|8|��|*�
����"�|�����|�¥�
8|"�Q
¥�\���

FCC Declaration of Conformity
Declaration of Conformity for Products Marked 
with FCC Logo, 

United States Only

This device complies with Part 15 of the FCC 
8!�����\J����
���
���!M��>������$�������G
����G��
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that 
may cause undesired operation. 

Commission Federale de la Communication 
(FCC Declaration)

 Cet équipement a été testé et déclaré 
conforme auxlimites des appareils 
numériques de class B,aux termes de 
l'article 15 Des règles de la FCC. Ces 
�
�
���������>���!���	��������¶���!�
��
une protection raisonnable contre les 
interférences nuisibles dans le cadre d'une 
installation résidentielle.  
 
CET appareil produit, utilise et peut émettre 
des hyperfréquences qui, si l'appareil n'est 
pas installé et utilisé selon les consignes 
données, peuvent causer des interférences 
nuisibles aux communications radio.  
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Cependant, rien ne peut garantir l'absence 
d'interférences dans le cadre d'une 
installation particulière. Si cet appareil est 
la cause d'interférences nuisibles pour 
la réception des signaux de radio ou de 
télévision, ce qui peut être décelé en 
fermant l'équipement, puis en le remettant 
en fonction, l'utilisateur pourrait essayer de 
corriger la situation en prenant les mesures 
suivantes:

#� 8·��
�������!�	·J��>����¸��������	��
réception.

#� Augmenter la distance entre l’équipement 
et le récepteur.

#� Brancher l’équipement sur un autre circuit 
que celui utilisé par le récepteur.

#� Demander l’aide du marchand ou d’un 
technicien chevronné en radio/télévision.

� ¥�!������	
�>��
�����¹�=����J������!�
l'approbation des services compétents 
en matière de conformité est susceptible 
	¹
����	
���¶��¹!�
�
����!���¹!�����	!�J�·�����
équipement.

�¹!�
�
����µ!��	���>ºM����8�����·��J�!��
les connections avec des ordinateurs ou 
périphériques. 

�|¥�
��
8|�Q����|8���|�]|�Q
��Q
��|�
Z�8|��|�¥|�¥\�¥|��Q|��|��"|��|��]��
8|"Q|�|�¥���8�Q|��
¥|8�|Q�Z8\��QQ|�8�
DU CANADA. 

EN 55022 Compliance (Czech Republic Only)

@��	
^�%������������
�	�������%���	
���	���
Notice
The equipment should draw power from a 
socket with an attached protection circuit (a 
three-prong socket). All equipment that works 
together (computer, monitor, printer, and so on) 
should have the same power supply source.

The phasing conductor of the room's electrical 
installation should have a reserve short-circuit 
protection device in the form of a fuse with a 
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the 
power supply cable must be removed from the 
power supply socket, which should be located 
near the equipment and easily accessible.


�J����>�
���������Z��>��������$����$��
equipment is in compliance with the protection 
usage requirements of standards PN-93/T-42107 
��	���*���|*&^�´��
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North Europe (Nordic Countries) Information

Placering/Ventilation 
VARNING:
FÖRSÄKRA DIG OM ATT HUVUDBRYTARE 
OCH UTTAG ÄR LÄTÅTKOMLIGA, NÄR 
DU STÄLLER DIN UTRUSTNING PÅPLATS.

Placering/Ventilation 
ADVARSEL: 
SØRG VED PLACER INGEN FOR , AT 
NETLEDNINGENS STIK OG STIKKONTAKT 
ER NEMT TILGÆNGELIGE. 

Paikka/Ilmankierto 
VAROITUS: 
SIJOITA LAITE SITEN, ETTÄ VERKKOJOHTO 
VOIDAAN TARVITTAESSA HELPOSTI 
IRROTTAA PISTORASIASTA. 

Plassering/Ventilasjon 
ADVARSEL: 
NÅR DETTE UTSTYRET PLASSERES, MÅ 
DU PASSE PÅ AT KONTAKTENE FOR 
STØMTILFØRSEL ER LETTE Å NÅ.

BSMI Notice (Taiwan Only)

Ergonomie Hinweis (nur Deutschland)
Der von uns gelieferte Farbmonitor entspricht 
den in der "Verordnung über den Schutz vor 
�>$»	���	!�>$�8¼���������$������������������
Vorschriften. 


!��	���8¦>�G��	�	���"��»����M���	����
>$�
ein Aufkleber, der auf die Unbedenklichkeit der 
Inbetriebnahme hinweist, da die Vorschriften 
¦M���	
��Z�!����?�����¼�����$�������>$�
������
����½�´�
M���~�	���8¼�����?����	�!������¦�����
�	��

Damit Ihr Monitor immer den in der Zulassung 
geforderten Werten entspricht, ist darauf zu 
achten, daß 

1. 8�J����!�����!��	!�>$���>$J��������
durchgeführt werden. 

2.  nur original-Ersatzteile verwendet werden. 
3. �M�
�|������	���Z
�	�¼$����!���
���

bauartgleiche eingebaut wird. 

Aus ergonomischen Gründen wird empfohlen, 
die Grundfarben Blau und Rot nicht auf 
dunklem Untergrund zu verwenden (schlechte 
Lesbarkeit und erhöhte Augenbelastung bei zu 
geringem Zeichenkontrast wären die Folge). 
Der arbeitsplatzbezogene Schalldruckpegel 
nach DIN 45 635 beträgt 70dB (A) oder 
weniger. 

 
�;¥��"%�Z|���
���¥|QQ|��
]�|�|��"|8¿¥|��]
8
���

�;¥|�@�]
À��|¥Á�¥|��|8���]�
NETZKABELANSCHLUß LEICHT 
Á�"¿�"Q��;����]��
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China RoHS 
¥$�����J��¹��8�J!M�
>�����$
����������	���
regulation called "Management Methods for 
Controlling Pollution by Electronic Information 
Products" or commonly referred to as China 
8�;���
���J��	!>���J��	!>�	���	����	������$
���
�������$�?�����������$
���8�;����µ!����

RoHS

(Pb) (Hg) (Cd) (Cr6+) (PBB) (PBDE)

O O O O O O

X X O O O O

X O O O O O

X O O O O O

X O O O O O

*:  

O:  

X:  

“X” RoHS
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter 
�`�{��
�|�&�

Philips tilstræber at levere produkter af den 
højeste kvalitet. Vi anvender nogle af branchens 
mest avancerede produktionsprocesser og udfører 
en streng kvalitetskontrol. En gang imellem er 
defekte pixler eller sub-pixler på TFT-skærme 
dog uundgåelige. Ingen producent kan garantere, 
at alle paneler vil være fri for pixeldefekter, 
men Philips garanterer, at enhver skærm med 
et uacceptabelt antal defekter repareres eller 
udskiftes under garantien. Dette notat forklarer de 
��������
��������������J
}��	�����������	��������
de acceptable defektniveauer for hver type. For 
at være berettiget til reparation eller udskiftning 
under garantien skal antallet af pixeldefekter på en 
TFT -skærm overskride disse acceptable niveauer. 
���������J����R�$X����&@&&&~+�����!M*J
}������
på en skærm være defekte. Desuden sætter Philips 
endnu højere kvalitetsnormer på visse typer 
eller kombinationer af pixeldefekter, der er mere 
generende end andre. Denne pixelpolitik gælder i 
hele verden.

pixler

sub-pixler

Pixler og sub-pixler
En pixel eller et billedelement er sammensat af 
tre sub-pixler med primærfarverne rød, grøn og 
blå. Når mange pixler sættes sammen, kan de 
danne et billede. Når alle sub-pixler i en pixel 
lyser, fremstår de farvede sub-pixler tilsammen 
som enkelt hvid pixel. Hvis de alle er mørke, 
fremstår de tre farvede sub-pixler tilsammen 
som en enkelt sort pixel. Andre kombinationer 
af oplyste og mørke sub-pixler fremstår som 
enkelte pixler i andre farver.

Forskellige typer pixeldefekter
Pixel- og sub-pixeldefekter optræder på 
skærmen på forskellige måder. Der er to 
�������
������J
}��	�����������������=J����!M*
pixeldefekter i hver kategori.

Defekte lyse prikker
Defekte lyse prikker (Bright Dot Defects) 
fremkommer som pixels eller underpixels, 
der altid lyser eller er "tændt". Det vil sige, at 
en lys prik er en underpixel, der fremstår på 
skærmbilledet, når skærmen viser et mørkt 
mønster. Der er følgende typer defekte lyse 
prikker.

En tændt rød, grøn eller blå sub-pixel.

To sammenliggende tændte sub-pixler :
*� 8X	�Â�Z�R�Ã�Q
���
*� 8X	�Â�"�X��Ã�"!�
*� "�X��Â�Z�R�Ã��=���`Q=��M�R{

Tre sammenliggende tændte pixler (en hvid 
pixel).
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Tætsiddende pixeldefekter
Da pixel- og sub-pixeldefekter af samme 
type, der ligger tæt på hinanden, kan være 
�����
X������	��	�@��J�>
�>������$
�
J�����R�
tolerancer for tætsiddende pixeldefekter.

Pixeldefekttolerancer
For at være berettiget til reparation eller 
udskiftning på grund af pixeldefekter i 
garantiperioden skal en TFT-skærm i en Philips 
��	������$�?��J
}��*��������!M*J
}��	�������@�
der overskrider de tolerancer, der er gengivet i 
følgende tabeller.

 Bemærk
En rød eller blå lys prik skal være mere end 50 
procent lysere end de omkringliggende prikker, 
mens en grøn lys prik er 30 procent lysere end 
de omkringliggende prikker.

Defekte mørke prikker
Defekte mørke prikker (Black Dot Defects) 
fremkommer som pixels eller underpixels, der 
altid er mørke eller er "slukkede". Det vil sige, 
at en lys prik er en underpixel, der fremstår 
på skærmbilledet, når skærmen viser et mørkt 
mønster. Der er følgende typer defekte mørke 
prikker.

BRIGHT DOT-DEFEKTER �%%'@��}'<��~0�'��
1 tændt sub-pixel 3
2 sammenliggende tændte sub-pixler 1
3 sammenliggende tændte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3
}<�%��A9�*A'�'��'� �%%'@��}'<��~0�'��
1 mørk sub-pixel 5 eller færre
2 sammenliggende mørke sub-pixler 2 eller færre
3 sammenliggende mørke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller færre
#��<'A'�A9�*A'�'��'� �%%'@��}'<��~0�'��
Samlede bright- eller black dot-defekter af alle typer 5 eller færre

 Bemærk
1. �����������������
����	���!M*J
}��*	��������Ã���	��*	�����
2. This monitor is ISO9241-307 compliant, Class-I compliant.(ISO9241-307: Testmetoder for 

ergonimiske krav, analyse og overensstemmelse på elektroniske visuelle skærme)
3. ISO9241-307 is the successor of formerly known ISO13406 standard, which is withdrawn by the 

��������
�����\����
���
�����������	��	
���
���`��\{�J��%��&&�*��*���
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7.2 Kundeservice og garanti
For oplysninger om garantidækning og gældende støttekrav i dit område, bedes du besøge www.
philips.com/support website for yderligere oplysninger. Du kan også kontakte dit lokale Philips 
kundeservicecenter via nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land CSP Nummer til 
kundeservice Pris Åbningstider

Austria 8¥� Â~��&��&�&&&�&^ € 0,07 Mon to Fri : 9am - 6pm
Belgium Ecare Â���&����´&�´� € 0,06 Mon to Fri : 9am - 6pm
Cyprus Alman �&&�����´^ Free of charge Mon to Fri : 9am - 6pm
Denmark Infocare Â~´��´�´���^� Local call tariff Mon to Fri : 9am - 6pm
Finland Infocare Â�´��&�����&���&� Local call tariff Mon to Fri : 9am - 6pm
France Mainteq Â���&���^���^´� € 0,09 Mon to Fri : 9am - 6pm
"�����= 8¥� Â~��&��&����^��´� € 0,09 Mon to Fri : 9am - 6pm
"���>� Alman Â�&�&&�&&���������� Free of charge Mon to Fri : 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff ���������
�%�����*�´J�
Italy Anovo Italy Â����~&���&�&~� Æ�&@&� Mon to Fri : 9am - 6pm
Luxembourg Ecare Â�´���^��~��&�&& Local call tariff Mon to Fri : 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0,10 Mon to Fri : 9am - 6pm
Norway Infocare Â~�����&���´& Local call tariff Mon to Fri : 9am - 6pm
Poland MSI Â~��&���~��´&´ Local call tariff Mon to Fri : 9am - 6pm
Portugal Mainteq �&&���&��&� Free of charge ���������
�%�����*�´J�
Spain Mainteq Â�~��&��������´ € 0,10 Mon to Fri : 9am - 6pm
Sweden Infocare Â~^�&��^���&&�^ Local call tariff Mon to Fri : 9am - 6pm
Switzerland ANOVO CH +41 02 2310 2116 Local call tariff Mon to Fri : 9am - 6pm
United Kingdom Celestica +44 0207 949 0069 Local call tariff ���������
�%�����*�´J�
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����������=
�	������	��%'~���<*�9���#�'��9@�Z

Land Callcenter CSP Kundeservice tlf

Belarus N/A IBA Â��´�����������^ 
Â��´������������

Bulgaria N/A LAN Service +359 2 960 2360
Croatia N/A �8����?
>��Q�	� Â��´�`&�{�^~&�����
���>$�8�J� N/A Asupport ~�&����������&&

Estonia N/A FUJITSU Â����^´���&&`"������{ 
+372 6519972(workshop)

"����
� N/A Esabi +995 322 91 34 71

Hungary N/A ��������?
>� Â�^�����~��&�&`"������{ 
Â�^����~��´^´`����
\�Ç�$
�
J�����={

Kazakhstan N/A Classic Service I.I.c. +7 727 3097515

Latvia N/A ServiceNet LV +371 67460399
+371 27260399

Lithuania N/A UAB Servicenet +370 37 400160(general) 
Â��&��~&&&���`�����$
�
J�{

Macedonia N/A AMC Â���������´&��
Moldova N/A Comel +37322224035
8����
� N/A Skin +40 21 2101969
8!��
� N/A CPS +7 (495) 645 6746
���M
�Ç���������� N/A Kim Tec d.o.o. Â��������&��&�^�~
Slovakia N/A Datalan Service +421 2 49207155
Slovenia N/A PC H.and Â��^���´�&�&���~
the republic of Belarus N/A ServiceBy Â���´������~�&�&�
Turkey N/A Tecpro Â�&�����~~~�~�����

Ukraine
N/A Topaz Â��&~~�´�´�^~��´
N/A Comel Â��&�´^��~~~��´

����������=
�	������	��<��0~��'�0��Z

Land Callcenter Kundeservice tlf
Brazil

Vermont 
&�&&*��´~�&�

Argentina &�&&����&��´^

Kontaktoplysninger til Kina:
Kina
�!�	����?
>�����%�~&&���&&�&&�
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����������=
�	������	��~9�A��'�0��Z

Land Callcenter Kundeservice tlf
U.S.A. EPI - e-center (877) 835-1838

Canada EPI - e-center (800) 479-6696

����������=
�	������	���@�'�Z

Land �#@ Kundeservice tlf Åbningstider

Australia 
"\���|¥�\8��
PTY LTD ��&&��^&���^ ����È��
���%&&��*�%�&J�

New Zealand [
�!���"��!J�Q�	�� &�&&�^´�~~� ����È��
���%�&��*´%�&J�

Hong Kong 
Macau

Company: Smart Pixels 
Technology Ltd.

Hong Kong: 
¥��%�Â�´���^����^�� 
Macau: 
¥��%�`�´�{*&�&&*���

Mon.~Fri. 9:00am-6:00pm  
Sat. 9:00am-1:00pm

India 8|]��"¥\����]�
�
LTD

¥��%����&&�~�´�^��^ 
SMS: PHILIPS to 56677 Mon.~Fri. 9:00am-5:30pm

Indonesia
�¥���\8����
�|8[����]\�
�|8�
�


Â^�*��*~&�&*�&�^�
(Customer Hotline) 
Â^�*����*&�*�&�^�
(Customer Hotline)

����È¥$!��&�%�&*��%&&Ê���%&&*
17:30  
��
��&�%�&*��%�&Ê���%&&*��%�&�

Korea Alphascan Displays, Inc 1661-5003 Mon.~Fri. 9:00am-5:30pm 
Sat. 9:00am-1:00pm

Malaysia 8*Q��
>��	��Z$	 +603 5102 3336 ����È��
���%�´��*´%&&J� 
������%�&��*��%�&��

Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm

Singapore

Philips Electronics 
Singapore Pte Ltd 
(Philips Consumer Care 
Center)

`^´{�^������^^ Mon.~Fri. 9:00am-6:00pm 
Sat. 9:00am-1:00pm

Taiwan FETEC.CO &�&&*���*&�� ����È��
��&�%&&�*���%&&

Thailand Axis Computer System 
Co., Ltd. `^^�{���~*´~�� ����È��
��&�%�&��È&´%�&J�

South Africa ���J!����8�J�
��
Technologies &�����^���´�^ ����È���
��&�%&&��È&´%&&J�

Israel Eastronics LTD �*�&&*´^�&&& �!��È¥$!��&�%&&*��%&&�

Vietnam
FPT Service Informatic 
Company Ltd. - Ho Chi 
Minh City Branch

Â�~������~�&&��
Ho Chi Minh City 
Â�~�´����´^�^^^�
Danang City 
Â�~�´����´^�^^^�
Can tho Province

����È��
���%&&*��%&&@���%�&*��%�& 
������%&&*��%&&
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Philippines |
�"��M����!JJ�=�
Chain Solutions ,Inc. `&�{�^´´*����Ê�^�´�~´^ ����È��
���%�&��È´%�&J�

Armenia 
Azerbaijan 
"����
� 
Kyrgyzstan 
Tajikistan

Firebird service centre Â����~�������� �!��È¥$!��&�%&&�*���%&&

Uzbekistan Soniko Plus Private 
Enterprise Ltd Â���������~^´& ����È��
��&�%&&�*���%&&

Turkmenistan Technostar Service 
Centre +(99312) 460733, 460957 ����È��
��&�%&&�*���%&&

Japan 03-5676-6022 ����È��
��&�%&&�*���%&&
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8. �����	��	���������

8.1 ����
��	��
Denne side omhandler problemer, som kan 
klares af brugeren selv. Hvis problemet stadig er 
der, efter at du har prøvet disse løsninger, skal 
du kontakte Philips' kundeservice.

� ��&	����	������X��&��

Intet billede (strømdiode lyser ikke)
#� Kontroller, at ledningen er sat i 

stikkontakten og bag på skærmen.
#� Kontroller først, at strømkontakten foran 

JR������������
�\���`�8
{@������
��	���
derefter på ON (TIL).

Intet billede (strømdiode lyser hvid)
#� Kontroller, at der er tændt for computeren.
#� Kontroller, at signalkablet er korrekt 

forbundet til computeren.
#� Kontroller, at der ikke er nogen bøjede 

stikben på signalkablets stik. Hvis der er det, 
skal du få kablet repareret eller udskiftet.

#� Energisparefunktionen kan være aktiveret

Skærm siger

Attention

Check cable connection

#� Kontroller, at signalkablet er korrekt 
���M!�	����
��>��J!�������`������R��!
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#� Tjek, om skærmkablets stikben er bøjede.
#� Kontroller, at der er tændt for computeren.

���9�����9���0#������������	�����	���
#� Den automatiske funktion fungerer kun i 
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tilfredsstillende, kan der foretages manuelle 
justeringer via OSD-menuen.

 Bemærk
Den Auto (Automatisk) funktion er ikke 
nødvendig i DVI-Digital-tilstand.

Synlige tegn på røg eller gnister
#� Forsøg ikke selv at fejlfinde
#� Træk straks skærmens stik ud af 

stikkontakten
#� Kontakt straks en repræsentant fra Philips 

kundeafdeling.

 Billedproblemer

Billedet er ikke centreret
#� Justér billedets position med funktionen 

"Auto" (Automatisk) i OSD-menuerne.
#� Juster billedpositionen med Phase/Clock 

(Fase/Klokke) i Setup (Opsætning) i OSD 
$�?�	���!����]��������!��M�!����
�["
*
tilstand.

Billede vibrerer på skærmen
#� Tjek, at signalkablet er korrekt forbundet til 

grafikkortet eller pc'en.

<������{	&���

#� Justér billedet med funktionen "Auto" 
(Automatisk) i OSD-menuerne.

#� Eliminer de lodrette bjælker med Phase/
Clock (Fase/Klokke) i Setup (Opsætning) i 
OSD hovedmenuen. Den kan kun bruges i 
["
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#� Justér billedet med funktionen "Auto" 
(Automatisk) i OSD-menuerne.

#� Eliminer de lodrette bjælker med Phase/
Clock (Fase/Klokke) i Setup (Opsætning) i 
OSD hovedmenuen. Den kan kun bruges i 
["
*�
�����	�
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Billedet er sløret, uklart eller for mørkt
#� Indstil kontrasten og lysstyrken i OSD.

Der forbliver et "efterbillede", 
"indbrændingsbillede" eller "spøgelsesbillede", 
efter at der er slukket for strømmen.
#� Uafbrudt visning af stille eller statiske billeder 

over en længere periode kan forårsage, at 
billedet "brændes fast" på skærmen, dvs. de 
såkaldte "efterbilleder" eller "spøgelsesbilleder" 
på din skærm. "Fastbrænding", "efterbilleder" og 
"spøgelsesbilleder" er velkendte fænomener 
inden for LCD teknologien. I de fleste tilfælde 
vil "brandmærkerne" eller "efterbilledet" eller 
"spøgelsesbilledet" forsvinde gradvist, efter 
skærmen er blevet slukket.

#� Sørg altid for at aktivere en pauseskærm, 
der bevæger sig, når skærmen efterlades 
uden at blive anvendt.

#� Du skal altid bruge en pauseskærm eller 
et andet program, der opdaterer skærmen 
regelmæssigt, hvis LCD skærmen viser 
statisk materiale i længere perioder.

#� Hvis der ikke bruges en pauseskærm 
eller et program, der opdaterer skærmen 
periodisk, kan der opstå alvorlige tilfælde 
af "fastbrænding" eller "efterbilledet" eller 
"spøgelsesbilledet", som ikke forsvinder, og 
som heller ikke kan repareres. Ovennævnte 
skader er ikke dækket af garantien.

Billedet er forvrænget. Tekst er utydelig eller 
sløret.
#� Indstil pc'ens skærmopløsning som 

skærmens anbefalede, native opløsning.

Der ses røde, blå, mørke og hvide pletter på 
skærmen
#� De resterende prikker er normale i den 

flydende krystal-teknik, der bruges i dag. 
Se politikken om pixels for yderligere 
oplysninger.

"Tændt" lyset er for kraftigt, og det er 
forstyrrende
#� Du kan justere "Tændt" lyset med 

Strømdiode i OSD-menuerne.

For yderligere hjælp, se venligst listen over 
Forbrugerinformationscentre og kontakt Philips's 
Kundeservice.

8.2 ��������#&���%�������@��&	+&
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til en anden skærm, og nu fungerer 
SmartControl Premium ikke længere. 
Hvad skal jeg gøre?

Sv.: "��������	
��J>������@����
SmartControl Premium fungerer nu. 
|����������	!�������������������
����������
SmartControl Premium for at sikre, at 
den korrekte driver er installeret.

���� #&���%�������@��&	+&��+��������
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tidligere, men nu virker programmet 
ikke længere. Hvad skal jeg gøre?

Sv.: Hvis nogle af de følgende handlinger har 
været udført, skal skærmdriveren måske 
geninstalleres.

#� Videografikadapteren er blevet udskiftet 
med en anden

#� Opdater videodriver
#� Aktiviteter i OS som f.eks. servicepakke 

eller programrettelse
#� Opdater Windows og opdater skærm- og/

eller videodriver
#� Windows blev startet med strømmen til 

skærmen slået fra eller afbrudt.
#� For at finde ud af dette, skal du klikke 

på "My Computer (Denne Computer)" 
og derefter på Properties (Egenskaber) 
-> Hardware -> Device Manager 
(Enhedshåndtering).

#� Hvis du ser "Plug and Play Monitor 
(Plug and Play skærm)" under Monitor 
(Skærm), skal du geninstallere. Afinstallér 
SmartControl Premium og geninstallér det.

���� '�����	�
������	������#&���%�������
Premium sker der ingenting, selv om 
jeg klikker på fanen SmartControl 
Premium og venter, eller der vises en 
fejlmeddelelse. Hvorfor?
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Sv.: ]�����=�	����!�
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ikke er kompatibel med SmartControl 
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af ovennævnte mærker, skal du prøve 
at downloade den mest opdaterede 
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geninstallér det igen.
Hvis det stadig ikke virker, er vi bange 
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SmartControl Premium.
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(Produktinformation), ses kun nogle af 
oplysningerne. Hvad er der sket?

Sv.: Det kan være, at din 
����������	�J���	�
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mest opdaterede version, som fuldt ud 
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at downloade den mest opdaterede 
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Premium og geninstallér det igen.

Attention

Theft Deterence is Enabled

���� ����^������&��&	��@0~*������	�����	*
tyveri funktionen. Hvad gør jeg?

Sv.: Philips servicecenter forbeholder sig 
retten til at bede om legitimation og 
godkendelse, for at kunne etablere 
skærmens ejer.

8.3 �������������

SP1: Hvad skal jeg gøre, hvis skærmen 
under installationen viser "Cannot 
display this video mode (Kan ikke vise 
denne videotilstand)"?

Sv.: Den anbefalede opløsning på denne 
�����%����&�}��&�~�?�	�^&�;��

#� Frakobl alle kabler og forbind derefter 
pc'en til skærmen, som du brugte før.

#� I Windows Start menuen, vælg Settings/
Control Panel (Indstillinger/Kontrolpanel). 
I Kontrolpanel-vinduet vælg Display 
(Skærm)-ikonet. I Display (Skærm) 
Kontrolpanel vinduet, skal du vælge 
"Settings" (Indstillinger) fanebladet. Under 
indstillinger-fanen, under feltet "Desktop 
Area" (skrivebordsområde), skal du stille 
�!����
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#� Åbn "Advanced Properties" (Avanceret 
�������M��{������
��8�����$�8����
(opdateringshastigheden) på 60 Hz og klik 
derefter på OK.

#� "��������>��J!������������������
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2 og 3 og bekræft, at pc'en er indstillet til 
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#� Luk for computeren, frakobl den gamle 
skærm og genforbind Philips LCD skærmen.

#� Tænd for skærmen og derefter for pc'en.

SP2: Hvad er den anbefalede 
opdateringshastighed på LCD skærmen?

Sv.: Den anbefalede opdateringshastighed 
på LCD skærme er 60 Hz. I tilfælde af 
forstyrrelser på skærmen skal du sætte 
den op til 75 Hz og se, om dette fjerner 
forstyrrelserne.

#@�Z� ���������	�������	�&�
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rom'en? Hvordan installerer jeg 
driverne (.inf og .icm)?

Sv.: ]�����������������	�
?��������
Installer driverne i henhold til 
brugervejledningen. Computeren kan 
bede dig om skærmdrivere (.inf og 
�
>������{�������������	�
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du installerer skærmen første gang. 
Indsæt (medfølgende cd-rom) i pakken i 
henhold til vejledningerne. Skærmdrivere 
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SP4: Hvordan justerer jeg opløsningen?
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Sv.: �����������������	�
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bestemmer sammen opløsningerne til 
rådighed. Du kan vælge den ønskede 
opløsning under "Display properties" 
(Egenskaber for Skærm) i Windows® 
Control Panel (Kontrolpanelet).

SP5: Hvad, hvis jeg "farer vild", mens jeg 
justerer skærmen?

Sv.: Tryk på knappen OK og vælg derefter 
"Nulstil" for at nulstille til alle originale 
fabriksindstillinger.

SP6: Er LCD-skærmen modstandsdygtig 
overfor ridser?

Sv.: Det anbefales generelt ikke at udsætte 
����������?����	�����������
�����X	��
Den er beskyttet mod skarpe og 
stumpe ting. Når du håndterer skærmen, 
så pas på ikke at trykke for kraftigt på 
����������?����	���]�������JR?
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garantibetingelserne.

SP7: Hvordan rengør jeg LCD skærmens 
����{����

Sv.: Til normal rengøring skal du blot 
anvende en ren, blød klud. Til kraftigere 
rengøring skal du bruge isopropylalkohol. 
Brug ikke andre opløsningsmidler såsom 
ethylalkohol, ethanol, acetone, hexan osv.

SP8: Kan jeg ændre skærmens 
farveindstilling?

Sv.: Ja, du kan ændre farveindstillingen via 
skærmmenuen på følgende måde:

#� Tryk på "OK" for at vise skærmmenuen
#� Tryk på "Ned-pil" for at vælge indstillingen 

"Color" (Farve), og tryk derefter på "OK" 
for at angive farveindstillingen. Der er tre 
indstillinger, som vist nedenfor.
1. Color Temperature (Farvetemperatur): 

de seks indstillinger er 5000K, 6500K, 
�´&&�@���&&�@���&&�������´&&�����	�
indstillinger i 5000K området virker 
skærmen "varm" med en rød-hvid 
farvetone, mens en 11500K temperatur 
giver en "kold" blå-hvid farvetone.

2. sRGB: dette er en standardindstilling, 
som sikrer korrekt udveksling af farver 
mellem forskellige enheder (f.eks. 
digitale kameraer, skærme printere, 
skannere osv).
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Brugeren kan vælge sin foretrukne 
farveindstilling ved at indstille den røde, 
grønne og blå farve.

 Bemærk
En målning af farven på lys, der udstråles fra 
et objekt, mens det opvarmes. Denne måling 
udtrykkes på en absolut skala (kelvingrader). 
Lavere kelvingrader såsom 2004K er røde, 
højere temperaturer såsom 9300K er blå. 
Neutral temperatur, 6504K, er hvid.

SP9: Kan jeg forbinde min LCD skærm til 
enhver pc, arbejdsstation eller Mac?

Sv.: Ja. Alle Philips LCD skærme er fuldt 
kompatible med standard pc'er, Mac og 
arbejdsstationer. En ledningsadapter kan 
være nødvendig for at kunne forbinde 
skærmen til dit Mac-system. Vi anbefaler, 
at du kontakter Philips salgsrepræsentant 
for yderligere oplysninger.

SP10: Er Philips LCD skærme "Plug & Play"?

Sv.: Ì�@���������������!��Ç����=����J��
M���
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OSX, Linux

SP11: Hvad er Billedklæbning eller 
Fastbrænding og Indbrændingsbillede 
eller Spøgelsesbillede på LCD skærme?

Sv.: Uafbrudt visning af stille eller statiske 
billeder over en længere periode 
kan forårsage, at billedet "brændes 
fast" på skærmen, dvs. de såkaldte , 
"efterbilleder" og "spøgelsesbilleder" 
på din skærm. "Fastbrænding", 
"efterbilleder" og "spøgelsesbilleder" 
er velkendte fænomener inden for 
Q�]���������
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"brandmærkerne" eller "efterbilledet" 
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eller "spøgelsesbilledet" forsvinde 
gradvist, efter skærmen er blevet slukket.
Sørg altid for at aktivere en pauseskærm, 
der bevæger sig, når skærmen efterlades 
uden at blive anvendt.
Du skal altid bruge en pauseskærm 
eller et andet program, der opdaterer 
skærmen regelmæssigt, hvis LCD 
skærmen viser statisk materiale i 
længere perioder.

 ������
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Hvis der ikke bruges en pauseskærm eller et 
program, der opdaterer skærmen periodisk, kan 
der opstå alvorlige tilfælde af "fastbrændinger", 
"efterbilleder" eller "spøgelsesbilleder", som ikke 
forsvinder, og som heller ikke kan repareres.  
Ovennævnte skade er ikke dækket af garantien.

SP12: Hvorfor viser skærmen ikke skarp 
tekst? Hvorfor viser den forrevne 
tegn?

Sv.: Din LCD monitor virker bedst på dens 
���
?���J�X��
���JR����&�}��&�~�?�	�^&�
Hz. Brug denne opløsning for at opnå 
det bedste billede.
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